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Welcome to Teachucomp, Inc.’s Introductory Outlook
course. This class introduces the student to Microsoft
Outlook, one of the most popular scheduling/e-mail
programs available today. This class is designed to give
the student knowledge of the e-mailing and scheduling
capabilities of the Outlook program.

Outlook is a terrific program to learn, as the skills that
we learn in Outlook can save valuable time and money by
automating, organizing and structuring the scheduling and
management capabilities of your company.

With Outlook you can track appointments, schedule
meetings, organize notes, and send and receive electronic
mail. It is a desktop information management system that
helps you organize and share information on your desktop
and communicate with others.

Introduction and Overview
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CHAPTER 7-
Tasks

7.1- Using Tasks

7.2- Printing the Tasks

7.3- Creating a Task

7.4- Setting Task Recurrence

7.5- Creating a Task Request

7.6- Responding to Task Requests

7.7- Sending Status Reports

7.8- Deleting Tasks
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Tasks

7.1- Using Tasks:

The Tasks folder helps you to organize and manage your workload. It keeps track of any tasks you
have to complete and reminds you when they are due. You can see the tasks in the Tasks folder. You can
also see them at the bottom of the “Day” view of your Calendar folder. You can also use Tasks to assign
work to colleagues. In this lesson we will explore how we can use this feature to assign tasks to ourselves
and others to manage our workload.

You can open the Tasks folder by clicking the “Tasks” button in the Navigation Pane. If you click the
“Folder List” button in the Navigation Pane, you can then click the “Tasks” folder icon in the Navigation
Pane to display it that way, as well.

By default, Outlook displays tasks in the “Tasks” folder using the “To-Do List” view. Tasks are listed
in a pane down the screen by due date. You can click the actual “Tasks” icon shown in the Navigation Pane
to see the tasks folder shown in the “Simple List” view, if you prefer. In the “Simple List” view, the tasks
appear as a traditional list that you can check off as you complete them. Overdue tasks are displayed in red
and completed tasks are shown with a strikethrough. Each task has a checkbox to its left that you can click
to check when you have completed the task. This will not delete the task from the list, but simply strikes it
out so that you can tell it has been accomplished. You would have to select a task that you wish to delete
and then press the “Delete” key on your keyboard in order to remove the task from the list and send it to the
“Deleted Items” folder.

To view the details of a task that you have placed in your Tasks folder, double-click on the required
task, and the Task window will appear. Once you have finished viewing the details of the task, you can
close it by clicking the “X” in the upper right corner of the Task window.

7.2- Printing the Tasks:

To print a copy of your task list, open the Tasks folder. If using Outlook 2010, click the “File” tab in
the Ribbon and then click the “Print” command at the left side of the backstage view shown. You can then
click the “Print Options…” button that appears to the right. If using Outlook 2007, click the “Print” button in
the Standard toolbar.

In the “Print” dialog box that appears, you can select a “Print range.” If you only wanted to print
selected rows, or tasks, then you would first need to have selected them in the task list prior to opening the
“Print” dialog box. In the “Copies” section, enter the number of copies to print, and check the “Collate
copies” checkbox to ensure a collated printing.

If using Outlook 2010, then click the “Preview” button to return to the backstage view, where you can
then click the “Print” button shown to print the task list. If using Outlook 2007, click “OK” to print the task list.
You can also click “Preview” to view it in Print Preview before printing the information in 2007, as well..

7.3- Creating a Task:

When you want to add a new task to your task list, click the “New Task” button in the “New” group on
the “Home” tab in the Ribbon when viewing the “Tasks” folder if using Outlook 2010, or on the Standard
toolbar if using Outlook 2007. In either version, you could also double-click in any empty row in the task list
to open the Task window.

In the “Subject:” text box, type the subject of the task. If you have to complete the task by a certain
date, click the drop-down arrow to the right of the “Due date:” text box to select a date from the calendar
drop-down. If the task has a start date, select the start date by clicking the drop-down arrow to the right of

Sam
ple

- fo
r e

va
lua

tio
n o

nly
.



6Introductory Outlook©TeachUcomp, Inc.

Tasks

7.3- Creating a Task (cont.):

the “Start date:” text box to select a date from the calendar drop-down.
Click the drop-down arrow to the right of the “Status:” text box to select the option which best

describes the status of this task. Click the drop-down arrow to the right of the “Priority” text box to select a
suitable priority for the task.

For longer projects, you can enter the amount of work completed on this task, by using the spinner
arrows on the “% complete:” text box.

You can also have Outlook issue a reminder for this task. To do this, check the “Reminder:” check
box to set a reminder. Then click the drop-down arrow to the right of the “Reminder:” box to select a
reminder date from the calendar. Set a reminder time by clicking the drop-down arrow to the right of the
date and selecting from the list.

Any additional information required to complete this task should be entered into the text area in the
bottom half of the dialog box. Also, as with appointments and meetings, you can also click the “Categorize”
button in the “Tags” group (“Options” group in 2007) on the “Task” tab in the Ribbon to associate the task
with one or more categories. In that same group, you can click the “Private” button to mark this as a private
task.

When you are ready, click the “Save and Close” button in the “Actions” group of the “Task” tab in the
Ribbon of the “Task” window to save the task and add it to your task list.

7.4- Setting Task Recurrence:

If the task you are creating is one that you repeat at regular intervals, you can set the recurrence as
you create the task. That way when you have completed the task, it will automatically regenerate itself for
the next date so that you do not have to worry about re-scheduling the task again every time you need to do
it. Once it is marked as completed in your “Tasks” folder, the next occurrence of the task that you will need
to accomplish will insert itself into your task list.

To set task recurrence, click the “Recurrence…” button in the “Recurrence” group (“Options” group
in 2007) of the “Task” tab in the Ribbon of the “Task” window to open the “Recurrence” dialog box. Here you
can set the recurrence pattern for the task.

In the “Recurrence Pattern” section, select the pattern of recurrence: “Daily,” “Weekly,” “Monthly” or
“Yearly.” In the area to the right of those option buttons, you will then have to specify the pattern for the
selected recurrence.

In the “Range of recurrence” section, set the “Start:” date of the recurrence pattern, and then select
when you want the recurrence pattern to end, if ever. When you are finished scheduling the recurrence of
the task, click “OK.”

After you have completed an instance of a recurring task, you can delete it from your task list.
However, sometimes there will be a recurring task that will no longer occur in the future. In this case you will
want to delete all of the future instances of that task.

To delete a recurring task you will need to open your task list and select the occurrence of the
recurring task that you want to delete. Press the “Delete” or “Del” key on your keyboard and you will see a
pop-up message box with two options: “Delete all” or “Delete this one.”

Select the option to “Delete this one” to delete just the selected occurrence of the task or select
“Delete all” to delete this and all future occurrences of the task. Click “OK” when you are done.
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7.5- Creating a Task Request:

Outlook allows you to assign tasks to other people to complete. This is the feature that you will
probably need to master if you are in charge of overseeing a project or a department. You create a task
request in much the same way that you create a task for yourself. If using Outlook 2010, click the “New
Items” drop-down button in the “New” group on the “Home” tab in the Ribbon and then select the “Task
Request” command from the drop-down menu that appears. If using Outlook 2007, select “File| New| Task
Request” from the Menu Bar. In the “Task Request” window that opens, you enter the task details. With a
task request, however, you must also fill in the “To:” field to send it to the person that you want to complete
the task, just as you would address an e-mail.

There are also two additional check boxes in task requests for “Keep an updated copy of this task
on my task list,” and “Send me a status report when this task is complete.” The first option will place your
name into the tasks update list. This list includes the person who originally sent the task as well as anyone
who received the task and assigned it to someone else or just elected to be placed in the update list. When
the status of the task changes, these people will receive an “update” e-mail telling them how much of the
task has been completed. This will not be the case for recurring tasks, however.

The second option will automatically generate a status report for anyone in the update list when the
task is fully completed. When you are done setting the options for the task, simply click the “Send” button in
the “Task Request” window to send it to the designated recipient.

Tasks

7.6- Responding to Task Requests:

When you receive a task request, it will appear in your “Inbox” folder. You can double-click it to view
the task, and then you must click one of the buttons in the top of the “Task request” window to let the person
who is assigning the task know whether you have accepted or declined the task. You do have a few
options. You can either: accept the task; accept the task with commentary; decline the task; decline the task
with commentary; or reassign the task to someone else.

When you accept a task by clicking the “Accept” button in the task request, a copy of the task is
placed on your task list. You can also send a comment as a response to the person that assigned the task
to you. You are now the owner of the task and are responsible for accomplishing the task.

When you decline a task by clicking the “Decline” button in the task request, you simply send a
response declining the task. You can choose to send additional commentary explaining why if you want to.
The task will not be added to your task list.

You could also reassign the task to someone else by clicking the “Assign Task” button. This will add
the “To:” field to the task request, where you can select or type the e-mail address of the person to whom
you wish to pass the task request. As a recipient of the task, your name will appear in the “Update” list for
the task. You can also check the two check boxes at the bottom of the task request to elect to retain an
updated copy of this task on your task list and receive a copy of the status report when it is completed.

If you are the recipient of the task, you can view the list of people who are on the update list by
simply opening the task and clicking the “Details” button in the “Show” group on the “Task” tab in the
Ribbon. The list of all the people who’ve elected to receive an update will be listed in the “Update list” box.Sam
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Tasks

7.8- Deleting Tasks:

You can simply click on a task that you want to delete in the “Task” folder, and then press the
“Delete” or “Del” key on your keyboard to delete the selected task.

7.7- Sending Status Reports:

If you are the “owner” of the task and it is your responsibility to complete the task, you can send an
update report to others. Whenever you complete the task and change the “Status” of the task to
“Completed” or enter in a “100 % complete” figure, the people on the update list will be automatically
notified. However, if you want to send a Status Report manually before that time, simply open the task and
click the “Send Status Report” button in the “Manage Task” group on the “Task” tab in the Ribbon of the
“Task” window. You can address it to as many people that you want to, but the names of the people who
requested updates will be automatically added.

Sam
ple

- fo
r e

va
lua

tio
n o

nly
.



9Introductory Outlook©TeachUcomp, Inc.

ACTIONS-
Tasks

USING THE TASKS FOLDER:

1. Click the “Tasks” button in the Navigation Pane.
2. Alternately, you could click the “Folder List” button in the Navigation Pane and select the “Tasks” folder 

from the list in the Navigation Pane.
3. By default, Outlook displays tasks in the “Tasks” folder using the “To-Do List” view. Tasks are listed in a 

pane down the screen by due date.
4. You can click the actual “Tasks” icon shown in the Navigation Pane to see the tasks folder shown in the 

“Simple List” view, if you prefer. In the “Simple List” view, the tasks appear as a traditional list that you 
can check off as you complete them. Overdue tasks are displayed in red and completed tasks are 
shown with a strikethrough. Each task has a checkbox to its left that you can click to check when you 
have completed the task. This will not delete the task from the list, but simply strikes it out so that you 
can tell it has been accomplished.

5. You would have to select a task that you wish to delete and then press the “Delete” key on your 
keyboard in order to remove the task from the list and send it to the “Deleted Items” folder.

6. To view the details of a task that you have placed in your Tasks folder, double-click on the required task, 
and the Task window will appear.

7. Once you have finished viewing the details of the task, you can close it by clicking the “X” in the upper 
right corner of the Task window.

PRINTING THE TASKS:

1. To print a copy of your task list, open the Tasks folder.
2. If using Outlook 2010, click the “File” tab in the Ribbon and then click the “Print” command at the left 

side of the backstage view shown. You can then click the “Print Options…” button that appears to the 
right. If using Outlook 2007, click the “Print” button in the Standard toolbar.

3. In the “Print” dialog box that appears, you can select a “Print range.” If you only wanted to print selected 
rows, or tasks, then you would first need to have selected them in the task list prior to opening the “Print” 
dialog box.

4. In the “Copies” section, enter the number of copies to print, and check the “Collate copies” checkbox to 
ensure a collated printing.

5. If using Outlook 2010, then click the “Preview” button to return to the backstage view, where you can 
click the “Print” button shown to print the task list. If using Outlook 2007, click “OK” to print the task list.

6. You can also click “Preview” to view it in Print Preview before printing the information in 2007, as well.

CREATING A TASK:

1. Click the “New Task” button in the “New” group on the “Home” tab in the Ribbon when viewing the 
“Tasks” folder if using Outlook 2010, or on the Standard toolbar if using Outlook 2007. In either version, 
you could also double-click in any empty row in the task list to open the Task window.

2. In the “Subject:” text box, type the subject of the task.
3. If you have to complete the task by a certain date, click the drop-down arrow to the right of the “Due 

date:” text box to select a date from the calendar drop-down.
4. If the task has a start date, select the start date by clicking the drop-down arrow to the right of the “Start 

date:” text box to select a date from the calendar drop-down. 
(cont.)
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ACTIONS-
Tasks

CREATING A TASK (CONT.):

5. Click the drop-down arrow to the right of the “Status:” text box to select a task status.
6. Click the drop-down arrow to the right of the “Priority” text box to select a suitable priority for the task.
7. For longer projects, you can enter the amount of work completed on this task, by using the spinner 

arrows on the “% complete:” text box.
8. You can check the “Reminder:” check box to set a reminder. Then click the drop-down arrow to the right 

of the “Reminder:” box to select a reminder date from the calendar. Set a reminder time by clicking the 
drop-down arrow to the right of the date and selecting from the list.

9. Enter any additional task-related information into the text area in the bottom half of the dialog box.
10. Also, as with appointments and meetings, you can also click the “Categorize” button in the “Tags” group 

(“Options” group in 2007) on the “Task” tab in the Ribbon to categorize the task.
11. In that same group, you can click the “Private” button to mark this as a private task.
12. When you are ready, click the “Save and Close” button in the “Actions” group of the “Task” tab in the 

Ribbon of the “Task” window to save the task and add it to your task list.

SETTING TASK RECURRENCE:

1. To set task recurrence, click the “Recurrence…” button in the “Recurrence” group (“Options” group in 
2007) of the “Task” tab in the Ribbon of the “Task” window to open the “Recurrence” dialog box.

2. In the “Recurrence Pattern” section, select the pattern of recurrence: “Daily,” “Weekly,” “Monthly” or 
“Yearly.” In the area to the right of those option buttons, you will then have to specify the pattern for the 
selected recurrence.

3. In the “Range of recurrence” section, set the “Start:” date of the recurrence pattern, and then select 
when you want the recurrence pattern to end, if ever. When you are finished scheduling the recurrence 
of the task, click “OK.”

4. To delete a recurring task you will need to open your task list and select the occurrence of the recurring 
task that you want to delete. Press the “Delete” or “Del” key on your keyboard and you will see a pop-up 
message box with two options: “Delete all” or “Delete this one.”

5. Select the option to “Delete this one” to delete just the selected occurrence of the task or select “Delete 
all” to delete this and all future occurrences of the task. Click “OK” when you are done.

CREATING A TASK REQUEST:

1. If using Outlook 2010, click the “New Items” drop-down button in the “New” group on the “Home” tab in 
the Ribbon and then select the “Task Request” command from the drop-down menu that appears. If 
using Outlook 2007, select “File| New| Task Request” from the Menu Bar.

2. In the “Task Request” window that opens, enter the task details.
3. Next, fill in the “To:” field with the e-mail address of the person that you want to complete the task.
4. Check either or both the “Keep an updated copy of this task on my task list” and “Send me a status 

report when this task is complete” checkboxes.
5. When you are done setting the options for the task, simply click the “Send” button in the “Task Request” 

window to send it to the designated recipient.
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ACTIONS-
Tasks

RESPONDING TO TASK REQUESTS:

1. When you receive a task request, it will appear in your “Inbox” folder. You can double-click it to open it.
2. Next, you must click one of the buttons in the top of the “Task request” window to let the person who is 

assigning the task know whether you have accepted or declined the task. You do have a few options. 
You can either: accept the task; accept the task with commentary; decline the task; decline the task with 
commentary; or reassign the task to someone else.

3. When you accept a task by clicking the “Accept” button in the task request, a copy of the task is placed 
on your task list. You can also send a comment as a response to the person that assigned the task to 
you. You are now the owner of the task and are responsible for accomplishing the task.

4. When you decline a task by clicking the “Decline” button in the task request, you simply send a 
response declining the task. You can choose to send additional commentary explaining why if you want 
to. The task will not be added to your task list.

5. You could also reassign the task to someone else by clicking the “Assign Task…” button. This will add 
the “To:” field to the task request, where you can select or type the e-mail address of the person to 
whom you wish to pass the task request. As a recipient of the task, your name will appear in the 
“Update” list for the task.

6. You can also check the two check boxes at the bottom of the task request to elect to retain an updated 
copy of this task on your task list and receive a copy of the status report when it is completed.

7. If you are the recipient of the task, you can view the list of people who are on the update list by simply 
opening the task and clicking the “Details” button in the “Show” group on the “Task” tab in the Ribbon. 
The list of all the people who’ve elected to receive an update will be listed in the “Update list” box.

SENDING STATUS REPORTS:

1. Whenever you complete the task and change the “Status” of the task to “Completed” or enter in a “100 
% complete” figure, the people on the update list will be automatically notified.

2. If you want to send a Status Report manually before that time, simply open the task and click the “Send 
Status Report” button in the “Manage Task” group on the “Task” tab in the Ribbon of the “Task” window.

3. You can address it to as many people that you want to, but the names of the people who requested 
updates will be automatically added.

DELETING TASKS:

1. You can simply click on a task that you want to delete in the “Task” folder, and then press the “Delete” or 
“Del” key on your keyboard to delete the selected task
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EXERCISES-
Tasks

Purpose:

1. To be able to create tasks in the Outlook application.

Exercises:

1. Open Outlook.
2. Click the “Tasks” category within the Navigation Pane.
3. Select the “Tasks” icon shown in the middle of the Navigation Pane.
4. If using Outlook 2010, click the “New Task” button in the “New” group on the “Home” tab in the

Ribbon. If using Outlook 2007, select “File| New| Task” from the Menu Bar.
5. In the “Task” window that appears, click into the “Subject:” text box and type “Learn Outlook.”
6. Click the “Recurrence” button in the “Recurrence” group (“Options” group in 2007) on the “Task” tab

in the Ribbon of the “Task” window.
7. In the “Task Recurrence” dialog box, select “Daily.”
8. Select “Every weekday” to the right of that.
9. In the “Range of recurrence” section, click the “End after:” option.
10. Type “5” after the “End after:” option button.
11. Click “OK” in the “Task Recurrence” dialog box.
12. Click “Save and Close” in the “Actions” group on the “Task” tab in the Ribbon of the “Task” window.
13. In the “Tasks” folder, click the checkbox next to the “Learn Outlook” task to mark it as completed.

The task with a due date of the next weekday should automatically generate itself.
14. Click on the “Learn Outlook” task that hasn’t been completed yet to select it.
15. Press the “Delete” or “Del” key on your keyboard.
16. Select the “Delete all” option button in the dialog box that appears.
17. Click “OK” to delete all instances of this task.
18. Click the “X” button in the upper-right corner of the application window to exit Outlook.
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